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MÔN: TOÁN 7 

A. LÝ THUYẾT 

I. Phần đại số  

1. Thống kê: Dấu hiệu điều tra, lập bảng tần số, số TBC, mốt của dấu hiệu. 

2. Biểu thức đại số, giá trị biểu thức đại số. 

3. Đơn thức, đơn thức đồng dạng. 

4. Đa thức, thu gọn đa thức. 

5. Đa thức 1 biến, tính tổng hiệu đa thức 1 biến 

6. Nghiệm của đa thức 1 biến. 

II. Phần hình học  

1. Các trường hợp bằng nhau của hai tam giác, của tam giác vuông. 

2. Tam giác cân, tam giác đều. 

3. Định lí Pitago 

4. Quan hệ giữa cạnh và góc đối diện trong tam giác; hình chiếu và đường xiên 

5. Bất đẳng thức trong tam giác 

6. Tính chất các đường đồng qui trong tam giác (đường trung tuyến, đường phân giác, đường trung 

trực, đường cao). 

B. BÀI TẬP THAM KHẢO 

I. Đại số  

Bài 1  Điểm kiểm tra môn toán học kỳ 2 của học sinh lớp 7A được thống kê như sau. 

10 9 10 9 9 9 8 9 9 10 

9 10 10 7 8 10 8 9 8 9 

9 8 10 8 8 9 7 9 10 9 

 a) Dấu hiệu ở đây là gì ? có bao nhiêu giá trị của dấu hiệu ? 

 b) Lập bảng tần số và nhận xét. 

 c) Tính số trung bình cộng của dấu hiệu; tìm mốt của dấu hiệu. 

Bài 2: Số cân nặng của 30 bạn (tính tròn đến kg) trong một lớp được ghi lại như sau: 

32     36      30       32      32       36      28      30       31       28 

30     28      32       36      45       30      31      30       36       32 

32     30      32       31      45       30      31      31       32       31 

a) Dấu hiệu ở đây là gì?     b) Lập bảng “tần số”    c) Tính số trung bình cộng. 

Bài 3: Tính giá trị của biểu thức: 

a) A = 2x2 −
1

,
3

y  tại x = 2 ; y = 9.          b) B = 2x2 + 3xy + y2 tại x = 1− ; y = 1.            

c) ( )
21

2
4

C xy x
 

= −  
 

 tại x = 2 ; y = 1     d) 2 22021 2020 3D x y x x y= + + −  tại 1; 1x y= = −   

Bài 4: Tính tổng của các đa thức: A = x2y − xy2 + 3 x2 và B = x2y + xy2 −2 x2 −1. 

 



 

 

Bài 5: Cho hai đa thức : 1322)( 23 +−+= xxxxA                     532)( 32 −−+= xxxxB  

a) Sắp xếp các đa thức theo lũy thừa giảm dần của biến.  

b) Tính A(x) + B(x) 

c) Tính A(x) – B(x) 

Bài 6:  Cho hai đa thức:      f(x) = 9 – x5 + 4 x −2 x3 + x2 – 7 x4 

                       g(x) = x5 – 9 + 2 x2 + 7 x4 + 2 x3−3 x. 

a) Sắp xếp các đa thức trên theo lũy thừa giảm dần của biến 

b) Tính hiệu f(x) - g(x)  

c) Tìm đa thức h(x) biết: h(x) − f(x) = g(x) 

d) Tìm nghiệm của đa thức h(x). 

 Bài 7:   Cho hai đa thức: 5 3 2 5 2( ) 4 4 5 9 4 6 2A x x x x x x x= − − + + + + − −  

    
4 3 2 3 3( ) 3 2 10 8 5 7 2 8B x x x x x x x x= − − + − + − − +  

a) Thu gọn mỗi đa thức trên rồi sắp xếp chúng theo lũy thừa giảm dần của biến. 

b) Tính P(x) = A(x) + B(x)  và  Q(x) = A(x) – B(x) 

c) Chứng tỏ x = –1 là nghiệm của đa thức P(x). 

II. Hình học:  

Bài 1: Cho ∆ABC có CA = CB = 10cm, AB = 12cm. Kẻ CI AB⊥ (I ∈ AB). 

a) Chứng minh: IA = IB                                      

b) Tính độ dài IC 

c) Kẻ IH⊥ AC (H ∈ AC), kẻ IK⊥ BC (K ∈ BC). So sánh IH và IK. 

Bài 2: Cho ∆ ABC vuông ở C,  có Â  bằng 600, tia phân giác của BAC cắt BC ở E. Kẻ EK⊥ AB (K ∈ 

AB). Kẻ BD vuông góc với tia AE (D ∈ tia AE). Chứng minh: 

a) AC = AK và AE⊥ CK. 

b) KA = KB 

c) EB > AC 

d) Ba đường thẳng AC, BD, KE cùng đi qua một điểm. 

Bài 3: Cho ∆ABC cân tại A và hai đường trung tuyến BM, CN cắt nhau tại K. Chứng minh: 

a) ∆ BNC=  ∆ CMB  b) ∆ BKC cân tại K  c) BC < 4KM. 

Bài 4: Cho ∆ ABC vuông tại A có BD là phân giác, kẻ DE⊥  BC ( E∈BC ). Gọi F là giao điểm của AB 

và DE. Chứng minh: 

a) BD là trung trực của AE                                 b)  DF = DC 

c)  AD < DC                                                       d)  AE // FC. 

Bài 5: Cho  ABC cân tại A. Gọi M là trung điểm của AC. Trên tia đối của tia MB lấy điểm D sao cho 

DM = BM 

a) Chứng minh  BMC =  DMA. Suy ra AD // BC.   

b) Chứng  minh ACD là tam giác cân. 

c) Trên tia đối của tia CA lấy điểm E sao cho CA = CE. Chứng minh  DC đi qua trung điểm I của 

BE 

III. Một số bài tập nâng cao 

Bài 1: 

   a) Xác định a để nghiệm của đa thức f( x ) = 2x - 4  cũng là nghiệm của đa thức  g(x) = x2 -ax + 2 

   b) Cho f(x) = ax3 + bx2 + cx + d, trong đó a,b,c,d là hằng số và thỏa mãn: b = 3a +c. Chứng tỏ rằng : 

f(1) = f(-2) 



 

 

Bài 2: Chứng minh rằng: M =
tzx

t

tzy

z

tyx

y

zyx

x

++
+

++
+

++
+

++
  (x, y, z, t N * )  

có giá trị không phải là số tự nhiên. 

Bài 3: ChoABC vuông cân tại A, trung tuyến AM. Lấy E  BC. Kẻ BH, CK⊥ AE (H, K  AE). 

Chứng minh rằng MHK vuông cân. 

 
BAN GIÁM HIỆU 

(Kí duyệt) 

 

 

 

 

Lê Thị Ngọc Anh 

TỔ CM 

(Kí duyệt) 

 

 

 

 

Nguyễn Thế Mạnh 

GV RA ĐỀ 

 

 

 

 

 

Đào Thị Quỳnh Anh 
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I. Trắc nghiệm: 

- Ôn tập các chương 

+ Đại cương về kĩ thuật chăn nuôi. 

+ Quy trình sản xuất và bảo vệ môi trường trong chăn nuôi. 

+ Đại cương về kĩ thuật nuôi thủy sản 

II. Tự luận: 

Câu 1. Nêu vai trò của ngành chăn nuôi trong nền kinh tế nước ta. Lấy ví dụ minh họa. 

Câu 2. Thức ăn vật nuôi là gì? Nêu vai trò của chất dinh dưỡng trong thức ăn đối với vật nuôi? 

Câu 3. Em hãy trình bày tiêu chuẩn chuồng nuôi hợp vệ sinh ?Muốn hình thành kiểu chuồng nuôi hợp 

vệ sinh ta phải làm như thế nào? 

Câu 4. Thế nào là sự sinh trưởng và phát dục của vật nuôi? Ví dụ?   

Câu 5. Nhiệm vụ chính của nuôi thủy sản 

Câu 6. Em hãy nêu các bước tiến hành nhận biết và chọn một số giống heo qua quan sát ngoại hình và 

đo kích thước các chiều? Từ số đo các vòng, hãy tính ước lượng cân nặng của heo 

 

 

BGH kí duyệt 

 

 

Lê Thị Ngọc Anh 

 

Tổ CM 

 

 

Nguyễn Thế Mạnh 

 

Nhóm CM 

 

 

Nguyễn Ngọc Phương 
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A. PHẠM VI KIẾN THỨC 

1. Châu Nam Cực  

2. Châu Đại Dương 

3. Châu Âu 

B. CÁC DẠNG BÀI  

I. Bài tập trắc nghiệm  

II. Bài tập tự luận: Một số câu hỏi gợi ý: 

Câu 1: Trình bày đặc điểm kiểu môi trường tự nhiên ôn đới hải dương của châu Âu? 

Câu 2: Trình bày đặc điểm: vị trí, địa hình và khí hậu của châu Nam Cực?  

Câu 3: Trình bày đặc điểm vị trí và địa hình châu Âu?  

Câu 4: Chứng minh Liên minh châu Âu - một mô hình liên minh toàn diện nhất thế giới? 

III. Bài tập thực hành 

Câu 1: Dân số của châu Âu năm 2020 là 747.723.443 người, diện tích là 10 triệu km2. Tính mật độ dân 

số của châu Âu năm 2020? 

Câu 2: Đọc bài báo sau:  

 “The secret of their success’’, The Economist, 02/02/2013. 

Phạm Vũ Lửa Hạ dịch và chú thích 

Các nước Bắc Âu có lẽ trị quốc tốt nhất thế giới 

Cecil Rhodes từng nhận xét rằng “sinh ra là người Anh coi như trúng số độc đắc”. Ngày nay ta 

cũng có thể nói như vậy về người sinh ra ở Bắc Âu. Các nước Bắc Âu không chỉ tránh được phần lớn 

những vấn nạn kinh tế đang làm rung chuyển vùng Địa Trung Hải mà còn tránh được phần lớn những 

căn bệnh xã hội đang hành hạ nước Mỹ. Xét về bất cứ chỉ số nào đo lường tình trạng ổn định và lành 

mạnh của một xã hội – từ các chỉ số kinh tế như năng suất và đổi mới sáng tạo đến các chỉ số xã hội 

như tình trạng bất bình đẳng và tội ác – các nước Bắc Âu hầu hết ở đầu bảng xếp hạng (xem bảng). 

Thứ hạng 

tổng quát 

Nước Khả năng 

cạnh tranh 

toàn cầu 

Mức độ dễ 

dàng kinh 

doanh 

Khả năng 

đổi mới 

sáng tạo 

toàn cầu 

Chỉ số 

nhận thức 

tham 

nhũng 

Phát triển 

con người 

Mức độ 

thịnh 

vượng 

1 Thụy Điển 4 13 2 4 10 3 

2 Đan Mạch 12 5 7 1 16 2 

3 Phần Lan 3 11 4 1 22 7 

4 Na Uy 15 6 14 7 1 1 

5 Thụy Sĩ 1 28 1 6 11 9 

Nguồn: Diễn đàn Kinh tế Thế giới; Ngân hàng Thế giới; INSEAD và Tổ chức Sở hữu Trí tuệ Thế giới; 

Tổ chức Minh bạch Quốc tế; UNDP. 

Em có nhận xét gì về đặc điểm kinh tế của các nước Bắc Âu sau khi đọc bài báo trên?  

 

C. HƯỚNG DẪN TRẢ LỜI 

I. Bài tập trắc nghiệm  

Ôn tập kiến thức các bài sau: Châu Nam cực – châu lục lạnh nhất thế giới; Thiên nhiên, dân cư và kinh 

tế châu Đại Dương; Thiên nhiên, dân cư, kinh tế - xã hội châu Âu; Liên minh châu Âu.  

II. Bài tập tự luận 

Câu 1: Bài 52: Thiên nhiên châu Âu (tiếp) 

Câu 2: Bài 47: Châu Nam Cực – châu lục lạnh nhất thế giới. 

https://www.economist.com/news/special-report/21570835-nordic-countries-are-probably-best-governed-world-secret-their


 

 

Câu 3: Bài 51: Thiên nhiên châu Âu  

Câu 4: Bài 60: Liên minh châu Âu. 

III. Bài tập thực hành 

Câu 1: Công thức tính MĐDS=  số dân/ diện tích (người/km2) 

Câu 2: Bài 56: Khu vực Bắc Âu.  

 

                        BGH                                     Tổ CM                                       Nhóm CM 

 

 

 

 

Lê Thị Ngọc Anh                 Nguyễn Thế Mạnh                       Phạm Thị Lan Anh 
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I. NỘI DUNG ÔN TẬP: 

- Ôn tập nội dung kiến thức các chủ đề: Ngành động vật có xương sống (Lớp Chim, lớp Thú), 

sự tiến hóa của động vật và động vật với đời sống con người. 

II. MỘT SỐ CÂU HỎI TỰ LUẬN 

Câu 1: Thế nào là biện pháp đấu tranh sinh học? Kể tên, nêu ưu điểm và hạn chế của các biện 

pháp đấu tranh sinh học. 

Câu 2: Thế nào là động vật quý hiếm. Nêu các cấp độ của động vật quý hiếm và ví dụ minh 

họa. 

Câu 3: Hiện tượng sinh sản của thỏ có gì tiến hóa hơn so với chim và thằn lằn? Hiện tượng 

sinh sản ở thỏ được gọi là gì? 

Câu 4: Vì sao chim là động vật hằng nhiệt, nhưng vào mùa đông, một số loài chim ở phương 

Bắc vẫn di cư về phương Nam? 

Câu 5: Giải thích tại sao thỏ chạy không dai sức bằng thú ăn thịt, nhưng trong một số trường 

hợp thỏ vẫn thoát được thú ăn thịt? 

 

*GỢI Ý TRẢ LỜI: 

Câu 1: Bài 59: Biện pháp đấu tranh sinh học Bài 51: Đa dạng của lớp Thú (tiếp theo) 

Câu 2: Bài 60: Động vật quý hiếm 

Câu 3: Bài 55: Tiến hóa về sinh sản 

Câu 4: Bài 44: Đa dạng và đặc điểm chung của lớp Chim 

Câu 5: Bài 46: Thỏ 

 

BAN GIÁM HIỆU TỔ CHUYÊN MÔN NHÓM CHUYÊN MÔN 

 

 

 

 

Lê Thị Ngọc Anh 

 

 

 

 

Khổng Thu Trang 

 

 

 

 

Thái Thị Thu Mơ 
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I. TRẮC NGHIỆM 

Câu 1: Để mở tệp văn bản có sẵn trong máy, em sử dụng lệnh nào? 

A. File/Copy.      B. File/New.                 C. File/Save.                   D. File/Open. 

Câu 2: Em sử dụng nút lệnh nào dưới đây để sao chép và dán văn bản? 

A.  và              B.  và    C.  và           D.  và  

Câu 3: Trong Microsoft Word, chức năng của nút lệnh  trên thanh công cụ định dạng là: 

       A. Dùng để thay đổi tỉ lệ hiển thị văn bản       B. Dùng để thay đổi màu chữ 

       C. Dùng để thay đổi cỡ chữ       D. Dùng để thay đổi kiểu chữ 

Câu 4. Muốn chèn hình ảnh vào văn bản phải thực hiện lệnh: 

A. Picture →  Insert → From File .  B. Insert → From File → Picture. 

C. Insert → Picture → From File.   D. Tất cả đúng. 

Câu 5. Nút lệnh    dùng để: 

 A. Căn thẳng lề trái          B. Căn thẳng lề phải        C. Căn giữa      D. Căn thẳng hai lề 

Câu 6. Trong Microsoft Word, chức năng của nút lệnh  trên thanh công cụ định dạng là: 

A. Dùng để chọn màu đường gạch chân          B. Dùng để chọn kiểu chữ 

C. Dùng để chọn cỡ chữ          D. Dùng để chọn màu chữ 

Câu 7. Khi soạn thảo văn bản trong các cách sắp xếp dưới đây, trình tự nào là hợp lí nhất? 

A. Trình bày → chỉnh sửa → gõ văn bản → in ấn. 

        B. Gõ văn bản → chỉnh sửa → Trình bày → in ấn. 

C. Gõ văn bản → trình bày → chỉnh sửa → in ấn. 

D. Gõ văn bản → trình bày →  in ấn  → chỉnh sửa. 

Câu 8. Để chèn thêm cột vào bên trái một cột trong bảng, trước hết ta đưa trỏ chuột vào một ô 

trong cột cần chèn thêm rồi thực hiện: 

A. Format→Columns to the Left.                         B. Insert→Columns to the Left 

C. Table→Insert→Columns to the Left.              D. Insert→Table→Columns to the Left. 

Câu 9. Muốn căn giữa văn bản ta sử dụng nút lệnh nào sau đây? 

A.    B.         C.              D.  

Câu 10. Để định dạng chữ "Quê hương" thành "Quê hương " ta sử dụng các nút lệnh nào sau 

đây?  

A.     và         B.   và    C.     và   D.   và  

Câu 11. Nếu đèn CAPS LOCK không được bật, em nhấn và giữ phím nào để khi gõ một phím 

chữ được một chữ hoa? 

A. Phím ENTER      B. Phím CAPS LOCK        C. Phím TAB         D. Phím SHIFT 

 

 



 

 

Câu 12. Có thể đặt hướng trang văn bản và các lề của trang bằng các thao tác nào? 

A. Format→Borders                  B. Nút lệnh  và  trên thanh công cụ 

C. Nút lệnh  trên thanh công cụ     D. File→Page Setup/ chọn các tính chất cần thiết 

Câu 13. Nút lệnh  có tác dụng: 

A. Khởi động máy in     B. Tắt máy in   C. In văn bản         D. Sao chép văn bản 

Câu 14. Để tạo bảng trong văn bản, em sử dụng nút lệnh: 

A.      B.       C.               D.  

Câu 15. Sử dụng phím Backspace để xoá từ TRONG, em cần đặt con trỏ soạn thảo ở đâu? 

A. Ngay trước chữ O B. Ngay trước chữ T 

C. Ngay trước chữ G D. Đặt ở cuối từ TRONG 

II. CÂU HỎI  TỰ LUẬN: 

Câu 1: Hãy nêu sự giống và khác nhau về ý nghĩa của con trỏ soạn thảo và con trỏ chuột. 

Câu 2: Thế nào là định dạng văn bản? Mục đích và phân loại định dạng văn bản. 

Câu 3: Thực hiện thao tác xem văn bản trên màn hình trước khi in có lợi ích gì? 

Câu 4: Trình bày các bước để chèn hình ảnh vào văn bản. Hình ảnh được chèn vào văn bản với mục 

đích gì? 

Câu 5: Trình bày các bước để chèn thêm hàng hoặc cột trong bảng. 

Câu 6: Bạn Trang gõ sai một cụm từ trong một văn bản dài và cụm từ đó xuất hiện rất nhiều lần. Bạn 

Trang đã sử dụng thanh cuốn, di chuyển con trỏ soạn thảo để tìm và sửa lại cụm từ đó trên từng dòng, 

từ đầu văn bản cho đến hết. Em có đồng ý với cách làm của ban Trang không? Hãy đưa ra ý kiến để 

cho thấy rằng cách làm đó không hiệu quả. Nếu là em thì em sẽ làm như thế nào? 
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I. Lý thuyết 

1. Sự nhiễm điện do cọ xát. 

2. Hai loại điện tích. 

3. Chất dẫn điện- chất cách điện. 

4. Các tác dụng của dòng điện. 

5. Cường độ dòng điện, hiệu điện thế của mạch nối tiếp, song song. 

II. Bài tập 

Bài 1. Đổi đơn vị sau: 

a) 0,35A=………………….mA. 

b) 425mA=………………….A. 

c) 500kV=………………….V. 

d) 220V=…………………..kV. 

Bài 2. Cho mạch điện có sơ đồ như hình sau.   

Khi công tắc K đóng, vôn kế V có số chỉ U = 5,8V, vôn kế V1 có chỉ số 

U1 = 2,8V. 

a. Tính cường độ dòng điện I1, I2 tương ứng chạy qua các bóng đèn 

Đ1 và Đ2 biết cường độ dòng điện chạy qua mạch chính là  

I= 2,5A. 

b. Tính hiệu điện thế U2 giữa hai đầu bóng đèn Đ2. 

c. Độ sáng của đèn sẽ thay đổi như thế nào nếu thay nguồn điện đã 

cho bằng một nguồn điện khác sao cho số chỉ của vôn kế V là 6V? 

Bài 3. Cho vôn kế sau: 

a) Xác định GHĐ và ĐCNN của vôn kế 

b) Dùng vôn kế trên có thể đo được giá trị hiệu điện thế nào trong 

các giá trị sau: 6,8V- 7,6V-  3,2V 

Bài 4. Cho các dụng cụ sau: 2 bóng đèn (Đ1 và Đ2), 1 ampe kế, 1 

vôn kế, 1 nguồn điện 2 pin mắc nối tiếp, 1 khóa K, dây dẫn.  

a) Vẽ mạch điện sao cho 2 đèn mắc nối tiếp, ampe kế đo cường độ của dòng điện của cả mạch, 

vôn kế đo hiệu điện thế của đèn 1 

b) Biết ampe kế chỉ 0,5 A; vôn kế chỉ 6V; nguồn điện có hiệu điện thế 9V. Hãy tính cường độ 

dòng điện chạy qua từng đèn, hiệu điện thế của đèn 
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A. HỆ THỐNG BÀI HỌC: 

I. PHẦN VĂN BẢN : 

1.  Giới hạn văn bản: 

- Tinh thần yêu nước của nhân dân ta. 

- Đức tính giản dị của Bác Hồ. 

- Ý nghĩa văn chương. 

- Sống chết mặc bay. 

- Ca Huế trên sông Hương. 

2. Yêu cầu  

- Nắm được vài nét về tác giả, tác phẩm, thể loại, phương thức biểu đạt, hoàn cảnh sáng tác, nội 

dung và nghệ thuật của mỗi văn bản. 

      - Lập bảng thống kê theo mẫu 

TT Tác phẩm Tác giả Thể loại Phương thức 

biểu đạt 

Nội dung, ý 

nghĩa 

Nghệ thuật đặc 

sắc 

       

II. PHẦN TIẾNG VIỆT 

       1. Giới hạn kiến thức: 

       - Các phép biến đổi câu:  

       + Rút gọn câu: câu rút gọn, câu đặc biệt. 

       + Mở rộng câu: thêm trạng ngữ cho câu, dùng cụm chủ - vị để mở rộng câu. 

       + Chuyển đổi kiểu câu: chuyển đổi câu chủ động thành câu bị động. 

       - Phép tu từ: liệt kê. 

       - Các loại dấu câu: dấu chấm lửng, dấu chấm phẩy, dấu gạch ngang. 

       2. Yêu cầu  

       - Khái niệm, phân loại, cách sử dụng, tác dụng của các đơn vị kiến thức. 

       - Vận dụng kiến thức Tiếng Việt đã học vào làm bài tập. 

III. PHẦN TẬP LÀM VĂN 

1. Dạng bài:  văn nghị luận  

2. Một số đề tham khảo:  

Đề 1:  Hãy giải thích ý nghĩa câu tục ngữ: Thất bại là mẹ thành công. 

Đề 2: Trình bày suy nghĩ của em về vấn nạn thuốc lá điện tử trong học đường hiện nay. 

Đề 3: Giải thích, chứng minh làm sáng tỏ câu tục ngữ: 

Một cây làm chẳng nên non 

Ba cây chụm lại nên hòn núi cao 

          Yêu cầu:  

      - Học sinh lập dàn ý chi tiết và viết thành bài văn hoàn chỉnh. 



 

 

      B. MỘT SỐ DẠNG BÀI CỤ THỂ  

Dạng 1: Chuyển các câu chủ động sau thành câu bị động: 

a. Ngoài chợ, những người bán hàng rong đã bày bán táo xanh đầu mùa. 

b. Tôi vừa làm xong đề cương ôn tập môn Ngữ Văn. 

c. Nhạc sĩ sáng tác bản nhạc dạt dào cảm xúc ấy chỉ trong thời gian ngắn. 

d. Các kiến trúc sư xây ngôi nhà này trong 7 năm.  

      Dạng 2: Tìm và nêu tác dụng câu đặc biệt, câu rút gọn trong các câu sau: 

       a. Ăn quả nhớ kẻ trồng cây. 

       b. Anh ơi! Bao giờ áo anh có rách, anh tìm về chỗ em, em vá cho anh nhé.  

c. Mẹ không lo nhưng vẫn không ngủ được. Cứ nhắm mắt lại là dường như vang bên tai tiếng đọc 

bài trầm bổng […] 

       d. Đình chiến. Các anh bộ đội nón lưới gắn sao kéo về đầy nhà Út... 

Dạng 3: Tìm cụm C-V trong các câu sau và cho biết những cụm C – V đó làm thành phần gì? 

a. Cuộc đời đầy sóng gió khiến chị ấy trưởng thành hơn. 

b. Con gái Huế nội tâm thật phong phú và âm thầm, kín đáo, sâu thẳm. 

c. Bức tranh treo trên tường đã bị mọt ăn gần hết. 

d. Trời mưa to làm cây cối ngả nghiêng. 

       Dạng 4: Tìm, phân loại và nêu tác dụng của phép liệt kê được sử dụng trong các câu sau: 

 a. Chúng ta có quyền tự hào vì những trang lịch sử vẻ vang thời đại Bà Trưng, Bà Triệu,Trần 

Hưng Đạo, Lê Lợi, Quang Trung… 

 b. Bên cạnh ngài, mé tay trái, bát yên hấp đường phèn để trong khay khảm, khói bay nghi ngút, 

tráp chữ nhật đồi mồi để mở, trong ngăn bạc đầy những trầu vàng, cau đậu, rễ tía, hai bên nào đồng 

hồ vàng, nào dao chuôi ngà, nào ống vôi chạm, ngoáy tai, ví thuốc, quản bút, tăm bông trông mà 

thích mắt. 

       c. Con gái Huế nội tâm thật phong phú và âm thầm, kín đáo và sâu thẳm. 

Dạng 5: Đặt câu theo yêu cầu cụ thể: đặt câu có sử dụng trạng ngữ, có sử dụng các loại dấu câu, 

các phép liệt kê. 

Dạng 6: Viết đoạn văn nghị luận văn học 

a. Hãy viết một đoạn văn ngắn từ 8 – 10 câu để chứng minh rằng “ văn chương gây cho ta những 

tình cảm ta không có”. 

b. Hãy viết một đoạn văn ngắn khoảng 6- 8 câu để giải thích ý nghĩa nhan đề của truyện ngắn “ 

Sống chết mặc bay” của Phạm Duy Tốn. 

Dạng 7: Bài tập tổng hợp: 

Đọc đoạn văn sau và trả lời các câu hỏi : 

“ Lịch sử đã có nhiều cuộc kháng chiến vĩ đại chứng tỏ tinh thần yêu nước của nhân dân ta. 

Chúng ta có quyền tự hào vì những trang lịch sử vẻ vang thời đại Bà Trưng, Bà Triệu, Trần Hưng 

Đạo, Lê Lợi, Quang Trung,…Chúng ta phải ghi nhớ công lao của các vị anh hùng dân tộc, vì các 

vị ấy là tiêu biểu của một dân tộc anh hùng”. 

a. Đoạn văn trên được trích từ tác phẩm nào? Tác giả là ai? 

b. Phương thức biểu đạt chính của đoạn văn trên. 

c. Trong đoạn văn trên tác giả có sử dụng biện pháp tu từ liệt kê. Em hãy chỉ rõ và nêu tác dụng 

của phép liệt kê trong đoạn văn trên. 



 

 

d. Chúng ta đang được sống trong độc lập, hòa bình đó là sự hi sinh biết bao xương máu của các vị 

anh hùng trong lịch sử, là học sinh em hãy nêu hai việc làm để giữ gìn nền độc lập, hòa bình của 

dân tộc trong thời đại hiện nay. 

 

Ban giám hiệu Tổ, nhóm chuyên môn Người lập 

 

 

 

Lê Thị Ngọc Anh 

 

 

 

Âu Thị Thùy Dung 

 

 

 

Đặng Thị Thu Huyền 
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A. SPEAKING 

CODE 1 

I. Introduction (5pts) 

-Introduce yourself ( names / age / hobbies….) 

II. Topic ( 15pts) 

 TRAFFIC 

1.What should you do to have traffic safety?  

2.When you are a road user, what should you NOT do?  

3.Should one drive after drinking alcohol? Why or why not? 

4.How do you go to school every day?  And how far is it from your house to school?  

CODE 2 

I. Introduction (5pts) 

-Introduce yourself ( names / age / hobbies….) 

II. Topic ( 15pts) 

  FILMS 

1. What kind of films do you like best? 

2. How often do you watch films? 

3. Do you prefer to watch films in the cinema or at home? 

4.Can you talk about your favourite film? 

CODE 3 

I. Introduction (5pts) 

-Introduce yourself ( names / age / hobbies….) 

II. Topic ( 15pts) 

FESTIVALS 

Talk about the festival you know  

1.What is the name of the festival? 

2. When and where is it held? 

3. What do they often do during the festival? 

5. What’s special about it?  

CODE 4 

I. Introduction (5pts) 

-Introduce yourself ( names / age / hobbies….) 

II. Topic ( 15pts) 

 SOURCES OF ENERGY 

1.What are some main sources of energy in Vietnam? 

2. Name some renewable sources of energy and non-renewable sources of energy. 

3. How is your carbon footprint? 

4. What do you do to save energy? 

CODE 5 

I. Introduction (5pts) 

-Introduce yourself ( names / age / hobbies….) 

II. Topic ( 15pts) 



 

 

TRAVELLING IN THE FUTURE  

1. What means of transport will people travel in the future? 

2.What is your favourite means of transport in the future? Why? How will it travel? 

3.How will people avoid trafic jam in the future? 

B. VOCABULARY AND GRAMMAR 

I. Vocabulary: 

From unit 7 to unit 12 

II. Grammar: 

1. Vocabulary: Unit 7-Unit 12 

2. Sounds: /e/ and /ei/, /t/, /d/, /id/ 

3. It indicating distance 

4. Used to 

5. -ed and –ing adjectives 

6. Connectors: although, despite/in spite of, however, nevertheless 

7. H/Wh-questions 

8. Adverbial phrases 

9. Word stress (two and three syllables) 

10. The future continuous tense 

11. The future simple passive 

12. Possessive pronouns 

13. Tag questions 

14. Comparisons of quantifiers 

15. Tag questions 

C. EXERCISES 

     I. Find the word which has a different sound in the part underlined. 

1. A. station   B. mistake   C. lane  D. many 

2. A. ready  B. break  C. ahead  D. dead 

3. A. pretty  B. depend  C. left   D. expensive 

4. A. straight  B. pain  C. said  D. afraid  

5. A. recycle  B. vehicle  C. helicopter D. reverse 

6. A. wished   B. gripped  C. loved  D. liked 

7. A. excited  B. enjoyed  C. bored   D. amazed  

8. A. laughed  B. ended  C. shocked  D. missed 

9. A. advertised  B. murdered  C. performed D. watched 

10. A. produced B. terrified  C. entertained D. engaged 

II. Circle the word with a different stress pattern from the others.  

1  A. project   B. picture   C. answer   D. record  

2  A. progress   B. increase   C. permit   D. result  

3  A. open   B. transfer   C. refund   D. suspect  

4  A. pregnancy   B. deliver   C. restaurant   D. interview 

5  A. solution   B. physician   C. confusion   D. poverty 

6  A. dedicate   B. terrify   C. recommend  D. recognize 

7  A. littering   B. serious   C. spacious   D. abundant 



 

 

8  A. polite   B. funny   C. lovely   D. busy 

9  A. describe   B. enter   C. agree   D. replace 

10  A. station   B. student   C. disease   D. winter 

III.Choose the best option to complete each sentence. 

1. My friend has a 3-year-old brother. The boy in this picture is __________ younger brother. 

A. her   B. hers  C. she   D. she’s 

2. __________ is described as a solar-powered car with 2 wings. 

A. Its   B. It   C. It's.   D. It is 

3. __________ bus is here, __________ will come in 5 minutes. 

A. Mine/ yours  B. Mine/ your C. My/ yours D.My/ your 

4. The ideas of the future plane are all__________? 

A. ours   B. our   C.us   D. we are 

5. There will be _________ places for children to play. 

A. more   B. less   C. much  D. None of them 

6. Children in poor areas have _________ time to study. 

A. many   B. fewer  C. less   D. Both A and B 

7. Hanoi has _________ skyscrapers than any other cities in the North of Vietnam. 

A. less   B. more  C. many  D. Both A and C 

8. Nowadays, there are _________ local people join in community tourism activities. 

A. less   B. more  C. much  D. Both B and C 

9. The countryside has _________ shopping centers than a big city. 

A. many   B. few   C. fewer  D. much 

10. In India, the demand for ___________ has always been more than the supply. 

A. shortage  B. sources  C. slogan  D. electricity 

11. ___________ energy is produced by collecting sunlight and converting it into electricity. 

A. Hydro   B. Nuclear  C. Solar  D. Wind 

12. There are many available ___________ power sources in Vietnam including sun, wind, 

water, etc. 

A. nuclear   B. hydro  C. renewable D. solar 

13. That was a _________ and boring horror film so I slept from the beginning to the end. 

A. shocking  B. entertaining C. gripping  D. predictable 

14. I didn't expect the movie to be so interesting and so _________! I cried at the end of the film. 

A. moving   B. violent  C. confusing  D. hilarious 

15. According to our latest survey, Batman is one of 10 _________ films this summer. 

A. must-see  B. violence  C. embarrassed D. stunt 

16. Woody Allen is one of some directors who _________ in their own films and receive positive 

reviews. 

A. set   B. star   C. recommend D. make 

17. The film had such a sudden and _________ ending that no one can imagine. 

A. disappointed  B. must-see  C. predictable  D. shocking 

18. Watching _________ films may make people more aggressive. 

A. hilarious  B. violent  C. entertaining  D. gripping 

19.___________ is part of the Thai New Year. People throw buckets of water on each other to 

wish for luck. 

A. Mid-autumn festival B. Easter  C. Thanksgiving D. Water Festival 

20.What I like about festivals is that they show the ___________ values of different 

communities. 



 

 

A. Carnival  B. culture  C. cultural  D. parade 

IV. Find the mistake in each sentence and rewrite the correct sentences. 

1. Despite of the film’s amazing effects, its plot is not so appealing. 

……………………………………………………………………………………. 

2. However she doesn’t look very beautiful, she has a kind heart. 

……………………………………………………………………………………. 

3. In spite that I don’t like her way of talking, I appreciate her effort. 

……………………………………………………………………………………. 

4. My brother isn’t very young, nevertheless, he talks like a middle-aged woman. 

……………………………………………………………………………………. 

5. Although the fact that Mary’s recently moved to this city, she is so familiar with it. 

……………………………………………………………………………………. 

6. I often eat fastfood. It is not, however, good for my health. 

……………………………………………………………………………………. 

7. My brother wants to travel around the world. Although he can’t afford it. 

……………………………………………………………………………………. 

V. Read the passage and choose the correct answer to complete the passage. 

Ewan McGregor 

Ewan McGregor was born in Scotland in 1971. He decided to be an actor when he was only 

nine and he (1)______ his first film in 1992. So far in his career he has (2)______ in a lot of 

different types of films, including comedies, musicals, dramas and the Star Wars movies. His 

uncle, Denis Lawson, was in the original Star War in 1977 and McGregor (3)______ in his 

first Star Wars movie 22 years later. In his career Ewan McGregor has worked with actresses 

like Cameron Diaz and Nicole Kidman, and his films have won lots of (4)______. He loves 

acting and when he finished (5)______ the musical, Moulin Rouge, he said, 'I have never been 

happier to do anything in my life.' 

1.A.made  B.played  C.worked  D.starred 

2.A.attended  B.appeared  C.joined  D.participated 

3.A.acted  B.performed  C.starred  D.took 

4.A.profit  B.money  C.presents  D.awards 

5.A.filming  B.film  C.to film  D.filmed 

VI.Read the passage and choose the correct answer for each question. 

     In Britain, the climate is not very good. There are very few hot days and it rains a lot. Because 

of this, people spend a lot of time at home. Generally, British homes have a lot of furniture in 

them, carpets on the floors and heavy curtains. 

     Many houses in Britain are old. Many of them are over one hundred years old. Often, they do 

not have enough insulation and the heat goes out through the windows, the doors and up the 

chimney. 

     Because of the climate, people in Britain have to spend a lot of money on heating. Many houses 

have a special system called "central heating". This heats all the rooms and, at the same time, 

heats the hot water. Houses without central heating often have gas, electric or coal fires. The 

rooms in most British houses are quite small. 



 

 

New houses are much better. They have two layers of glass in the windows to stop the heat 

going out. 

1.Why do British people spend a lot of time at home? 

A.Because the climate is not very good. B.Because they don’t know where to go. 

C.Because the climate is very good.  D.Because they want to stay at home. 

2.The heat goes out of the houses through ___________. 

A.the doors and up the chimney  B.the windows and up the chimney 

C.the windows, the doors and up the chimney D.the walls and up the chimney 

3.Because of ___________, people in Britain have to spend a lot of money on heating. 

A.cold weather B.cool weather C.hot weather  D.bad weather 

4.Houses without central heating often have ___________. 

A.only coal fires  B.gas or coal fires 

C.electric or coal fires D.gas, electric or coal fires 

5.New houses usually have ___________ in the windows to stop the heat going out. 

A.one layer of glass  B.two layers of glass  

C.three layers of glass D.two or three layers of glass 

VII.Rewrite the sentences, using the words in the brackets. Change other words in the 

sentence if necessary. 

1. The new restaurant looks good. It seems to have few customers. (however) 

...................................................................................................................... ? 

2. We planned to visit Petronas in the afternoon. We could not afford the fee. (however) 

........................................................................................................................ 

3. Mary was sick. She didn’t leave the meeting until it ended. (despite) 

....................................................................................................................... 

4. We live in the same street. We rarely see each other. (in spite of) 

........................................................................................................................ 

5. I couldn’t sleep. I was tired. (in spite of) 

........................................................................................................................ 

6. They have little money. They are happy (despite) 

........................................................................................................................ 

7. My foot was hurt. I managed to walk to the nearest village. (although) 

........................................................................................................................ 

8. I’ve been too busy to answer by email. I’ll do it soon. (nevertheless) 

........................................................................................................................ 

9. We had planned to walk right round the lake. The heavy rain made this impossible. (although) 

........................................................................................................................ 

10. I got very wet in the rain. I had an umbrella. (although) 

........................................................................................................................ 

VIII.Rewrite the following sentences in passive voice. 

1.Students will use public transport to go to school. 

........................................................................................................................ 

2.Solar power will generate a great deal of electricity this summer. 

........................................................................................................................ 

3.They will build a hydro power station in this area. 

........................................................................................................................ 



 

 

4.Local people won't burn plants to heat this winter. 

........................................................................................................................ 

5.The smoke from factories will pollute the air. 

........................................................................................................................ 

IX. Add tag questions to the following sentences. 

 1. Everyone can learn how to swim,    ? 

 2. Nobody cheated in the exam,    ?   

 3. Nothing went wrong while I was gone,    ? 

 4. I am invited,    ? 

 5. This bridge is not very safe,    ? 

 6. He has a bicycle,    ? 

 7. Peter would like to come with us to the party,   ? 

 8. Those aren’t Fred’s books,    ? 

 9. You have never been to Paris,   ? 

 10. Something is wrong with Jane today,   ? 

X.Make questions for the underlined words in the following sentences. 

1.People eat traditional foods in this festival. 

........................................................................................................................ 

2.Children are very happy because they receive a lot of lucky money from their relatives. 

........................................................................................................................ 

3.Diwali celebrations often last about five days. 

........................................................................................................................ 

4.In the USA, Thanksgiving is celebrated on the fourth Thursday of November. 

........................................................................................................................ 

5.We took these photos at the Tulip Time Festival in Holland. 

........................................................................................................................ 

6.People danced and played some folk games during the Spring Festival. 

........................................................................................................................ 

 

 

 

 

 

Ban giám hiệu 

 

 

 

Lê Thị Ngọc Anh 

 

Tổ/ Nhóm chuyên môn 

 

 

 

Người lập 

 

 

 

Bùi Thị Thu Hạnh 
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I. Hệ thống bài học:  

- Bài 24: Khởi nghĩa nông dân Đàng Ngoài. 

- Bài 25: Phong trào Tây Sơn. 

- Bài 26: Quang Trung xây dựng đất nước. 

- Lịch sử địa phương: Thăng Long từ đầu thế kỉ XV- cuối thế kỉ XVIII. 

II. Yêu cầu cần đạt: 

1. Kiến thức: 

- Học sinh trình bày được: 

+ Tình hình chính trị, xã hội nước ta giữa thế kỉ XVIII. 

+ Những cuộc khởi nghĩa nông dân Đàng Ngoài thế kỉ XVIII. 

+ Những diễn biến chính về phong trào Tây Sơn. 

+ Những đóng góp của Quang Trung trong việc xây dựng đất nước và ý nghĩa của những đóng góp 

ấy. 

- HS phân tích được nguyên nhân thắng lợi và ý nghĩa lịch sử của phong trào.  

2. Năng lực: 

- Tái hiện lịch sử, khái quát, tổng hợp kiến thức; so sánh, đối chiếu, phân tích, nhận xét, đánh giá; 

liên hệ thực tế, rút ra bài học, ý nghĩa lịch sử. 

- Thực hành các dạng bài tập lịch sử. 

III. Câu hỏi cụ thể:  

Câu 1: Nêu những biểu hiện suy thoái của chính quyền Đàng Ngoài và Đàng Trong nửa sau thế kỉ 

XVIII? Hậu quả của sự suy thoái đó? 

Câu 2: Lập niên biểu về hoạt động của phong trào Tây Sơn từ năm 1771 đến 1789? 

Câu 3: Trình bày nguyên nhân thắng lợi và ý nghĩa lịch sử của phong trào Tây Sơn?   

Câu 4: Nêu những chính sách của vua Quang Trung trong việc phục hồi, phát triển kinh tế, văn 

hóa, giáo dục và quốc phòng ngoại giao? Việc ban bố “Chiếu lập học” thể hiện hoài bão gì của vua 

Quang Trung? 

Câu 5: Ngày 5 tháng 1 âm lịch hàng năm ở Hà Nội diễn ra lễ hội nào? Trình bày hiểu biết của em 

về lễ hội đó? 

 

 

Ban giám hiệu                    Tổ-nhóm chuyên môn                          Người lập   

 

  

 

 

        Lê Thị Ngọc Anh                   Nguyễn Thị T. Huyền                     Nguyễn Thị Bích 
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A/ HỆ THỐNG BÀI HỌC 

1. Bài 15: Bảo vệ di sản văn hóa. 

2. Bài 16: Quyền tự do tín ngưỡng, tôn giáo.  

3. Bài 17: Nhà nước cộng hòa xã hội chủ nghĩa Việt Nam.  

4. Bài 18: Bộ máy nhà nước cấp cơ sở (Xã, phường, thị trấn). 

B/ BÀI TẬP: 

 1/Bài tập sau mỗi bài học trong sách giáo khoa. 

 2/Giải quyết được một số tình huống có liên quan đến từng chủ đề. 

 3/Tìm và giải thích được một số tục ngữ, thành ngữ, ca dao, danh ngôn,…liên quan đến từng chủ 

đề. 

 4/Liên hệ bản thân và có hành động cụ thể trong giải quyết tình huống thực tiễn… 

C. MỘT SỐ CÂU HỎI CỤ THỂ: 

Câu 1: Thế nào là tín ngưỡng, tôn giáo, mê tín dị đoan? Lấy ví dụ cụ thể.  

Câu 2: Hãy nêu 04 việc làm để thực hiện tốt quyền tự do, tín ngưỡng, tôn giáo của công dân? 

Câu 3: Thế nào là di sản văn hóa? Có những loại di sản văn hóa nào, trình bày ngắn gọn hiểu biết 

của em về loại di sản đó? Với mỗi loại di sản văn hóa em hãy lấy 2 ví dụ cụ thể.  

Câu 4: Là học sinh, em có những hành động gì để góp phần bảo vệ di sản văn hóa? 

Câu 5: Bài tập tình huống 

Tình huống 1: M là người theo Thiên Chúa giáo nên trong chuyến đi cắm trại, M mang Kinh 

Thánh ra đọc trước giờ đi ngủ. Một số bạn trong lớp mang điều đó ra bàn tán, chế giễu, thậm chí 

bạn N còn có ý định tẩy chay M vì cho rằng những người theo tôn giáo là mê tín dị đoan, tin vào 

những thứ không có thật.  

a) Em có nhận xét gì về việc làm của bạn N và các bạn trong lớp trong tình huống trên? 

b) Giả sử nếu em là một bạn học sinh trong lớp cũng có mặt trong tình huống đó, em sẽ làm 

gì? 

Tình huống 2: Gia đình nhà A có truyền thống làm nghề đúc đồng. A thường cùng bố đến nhà thờ 

tổ nghề để thắp hương tưởng nhớ công ơn của người đầu tiên truyền dạy nghề đúc đồng cho dân 

làng. Một số bạn trong lớp cho rằng, việc làm của A và gia đình chính là biểu hiện của mê tín.  

a) Theo em, việc làm của gia đình A có phải biểu hiệu của mê tín không? Vì sao? 

b) Nếu em là A, em sẽ giải thích như thế nào với các bạn? 

 


